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Introduction 
The information in these notes is a collection of more detailed instructions and 
suggestions for doing the various activities that comprise this course. The definitive 
course rules and procedures are contained in the Syllabus. You are responsible for being 
thoroughly familiar with both of these documents. You should read them several times 
during the semester and them reread various sections as the need arises. For example, if 
you are about to start an experiment using a radioactive source, reread the radiation safety 
section, reread the section on writing reports before you begin your first report, etc. You 
may expect to be asked about any material relevant to a given experiment in your pre-
experiment discussion.  

Experimental Procedures 
There are two equally important challenges to doing an experiment: The first is to 
develop procedures and techniques which, given the equipment, allow you to get the best 
possible results. The second is to convince those who look at your results that they mean 
what you claim; otherwise all your work is wasted. 
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Listed below are some of the steps which are crucial to a successful experiment and 
report. The list is not strictly chronological since there is a lot of feedback among the 
various steps. 

• Understand the physics that you will be studying. Before you appear in the lab 
to begin work on an experiment, you should have studied the write-up and some 
of the references both to familiarize yourself with the physics involved and to see 
what experimental techniques others used. 

• Understand the equipment you will be using. When you begin work on an 
experiment you should meet with one of the staff experts to discuss the 
equipment, which may not be working exactly as described in the write-up. In 
general the equipment is complex. If you do not understand how it is supposed to 
work, and how it is actually working you will almost certainly make errors in 
your measurements. 

• Decide what you wish to demonstrate, e.g. that you wish to determine the 
lifetime of the muon, and decide what is the required accuracy of the 
measurement techniques to do this. This requires to think beforehand about the 
errors. 

• Demonstrate that you are not making mistakes in your measurements. This 
mainly involves demonstrating a thorough understanding of all aspects of the 
measurement process as well as developing experimental cross checks wherever 
possible to demonstrate the validity of your results. 

• Determine the final uncertainty of your result. This involves knowing the 
accuracy of your instruments, the statistical uncertainty due to noise of counting, 
the reproducibility of your results and often an estimate of the residual errors due 
to your incomplete understanding of the measuring process. You should make 
every effort to reduce this last item to a negligible level. 

• Data taking: All the work you do in the lab is to be recorded directly into your 
lab book as you do it. If it is necessary to make large tables of data (either "by 
hand" or from a computer printout), one of you can make/take the "master copy". 
The other can make a photocopy of these data, so it is not necessary for both 
partners to copy large tables of data. This laboratory log will certainly (and 
should) contain all the mistakes you are making as you are learning. Simply note 
them and continue. These mistakes will not be held against you; rather, they are a 
record of how you "found your way" through the experiment. This log should be a 
fully literate record, readable and interpretable by you or somebody else after a 
long delay. Your daily log should also include block or schematics of apparatus, 
and all the pot or other settings on the electronics. This way, if you have to 
continue at the next session you can check that your settings have not been 
changed! (Another group may be using the equipment on the day(s) that you are 
not using it.) You should enter comments when changes are made, neatly labeled 
tables of data taken, estimates of reading errors and other sources of error. 

• Data analysis: You must analyze your data while you are doing the experiment. 
This is the only way to spot mistakes and improve your techniques and determine 
if you are finished, while you can still take corrective action. Make a rough graph 
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of the data immediately to see if the data make sense. This is the "quick and dirty" 
analysis that you and your partner are permitted to do together. However, each of 
you MUST do the final analyses of data SEPARATELY. 

Some experiments require you to be in the lab outside of regular course hours. For these 
situations the following rules apply: 

• You must be signed in on the sheet hanging on the door any time you are in the 
lab after normal hours. 

• You must have staff permission (TA or professor) to be in the lab after hours. 
• For safety reasons you may not be in the lab alone. 
• After-hours work is only an add-on to the regular class attendance. You cannot 

substitute after-hours attendance for the regular class hours. 

How to Keep an Good Log Book 
Remember: The preparation, experimental work, rough "in-lab" data analysis is/may be 
done with a partner, but record the data in your own log book. All the final analysis and 
the writeup must be done independently. 

At least Two notebooks are essential. One notebook, carrying a complete log and report, 
will be handed in for grading, while you are using the other notebook for a new 
experiment. 

The log book must be bound (cloth bound or spiral) and each page must be numbered. 
You may want to select a notebook which has graph paper in it. The spiral-bound 
"Engineering/Science" notebooks with alternate pages graph and lined paper are 
recommended but not required. 

You may start taking notes in your logbook even before the start date, when you are 
making notes/calculations and preparing for the experiment. The activities, instrument 
settings in the lab should be recorded so that you (or another reader) are able to 
reconstruct the events even years after the data were taken. It is very important to keep 
track of dates and record the time of day for all data you take and analyses that you 
do. 

Do not try to erase the records if you made a mistake! Making a mistake will not be held 
against you; not noticing a mistake will be. 

It is a good practice to take notes on one side of the pages and put graphs on the other 
side. Always do a quick check (graphical or otherwise) of your data as you collect them 
in the laboratory. Make sure that you are obtaining decent results, not nonsense. 
Remember that the brain is exceedingly efficient at assimilating and interpreting patterns 
(i.e. graphs) after millenia of selective evolution. Evolution has not prepared us to digest 
numerical tables! Even in the age of computers, do not hesitate to graph data by hand, 
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preferably right after (or during) the time of data collection. Alternatively, enter the data 
into a spreadsheet program like EXCEL on the spot, and create, print and paste the graph 
to the logbook. (See the example at the end of this section) Do not wait until some "later 
time" to find out that your data are worthless. 

Data taken by using a computer should be recorded in the log book by date/time/filename 
and the parameters changed between the subsequent data sets. Back up all data/analysis 
files on a floppy disk that you keep in a safe place. WARNING: Practice safe computing. 
Viruses have occurred in the lab computers. 

Computer printouts may/should be included in the log book, but no loose sheets allowed. 
Any such sheet must be taped/glued/stapled into the book. A written note of the date, 
time and circumstances belonging to that particular data set or graph should be there as 
well. 

Perform/record your data evaluation in the log book as well. The graphs that do not make 
it to the final report should be placed in the logbook. 

Data evaluation in your logbook 

Consider the following data, taken for some situation where supposedly the current is 
proportional to the square of the voltage; I = V2 . 
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In a table the data are not particularly instructive. The graph on the top right side shows 
this data in a graphical format. Is it a quadratic relationship? Hard to say; it may be 
perhaps cubic. The two lower graphs show I0. 5 vs. V (left) and I vs. V2 (right). The lines 
are guide to the eye, not the results of a fitting procedure. Nevertheless, it is much clearer 
that the quadratic dependence is at least nearly true. Is the departure from the "pure" 
quadratic dependence (clearly seen on the left-hand graph) significant? Maybe, maybe 
not. No error bars are indicated, so we can't tell. The deviation might be due to a 
systematic error in the measurement - or could it be a true departure from the supposed 
physical dependence between I and V? This is where your skill as an experimentalist 
comes in, and why it is important to keep a good lab notebook with data plotted as it is 
taken. 

Writing Experiment Reports 
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The main goals of your report are to present your results to an educated reader and to 
convince that reader that those results are correct. Some points to consider in achieving 
these goals are as follows: 

• The report must be logically organized to support your conclusions. 
Chronological organization is not satisfactory. 

• Your report must demonstrate that you have understood the equipment and have 
made appropriate experimental checks to confirm the validity of your data. Do not 
just copy descriptions of the apparatus from the write-up or other literature. The 
equipment never works the way it is supposed to. You must show that you have 
discovered and understood the various pathologies present. 

• It is necessary to include some description of the physics or theory of what you 
are doing in order to make your results intelligible. This discussion should be well 
focused and kept to the absolute minim required for a clear discussion of your 
results. If you must include such things as derivations, use an appendix and do not 
interrupt the logical flow of your report. 

• Error analysis: The uncertainty in your data is as important as the data. You 
should obtain the theoretical background for error analysis from Bevington and 
Robinson. You must show that you have understood the various uncertainties in 
your measurements and apparatus and have done appropriate error analysis to 
determine the accuracy of your final results. If you use formal error analysis, be 
sure you have an intuitive understanding of the results. 

• You may use the computers in the lab or any other computer to which you have 
access. You may use any programming language or software package you choose, 
but you are responsible for knowing what a "canned" data-analysis software 
package does and demonstrating before you use it that it gives correct results. 
(See the handout on least-squares fits using the EXCEL spreadsheet, and/or the 
Turbo Pascal programs in Bevington and Robinson.) 

• You should compare your results to similar results in the literature. You should 
learn how and where to find published data. The first step may be the "CRC 
handbook" (always available in the lab), but you may want to go well beyond 
that. 

• Don't "fudge" your results. Try to come up with a logical reason or reasons for 
discrepancies between your values and others. Hopefully you will be able to 
explain any differences. Random speculation is not useful. You must be able to 
support your conclusions. Obviously, if you have analyzed your data while you 
are doing the experiment, you have the best chance of finding out what happened 
if something went wrong. 

• Always give full references to other work which has been used or quoted in your 
report. 

If you are not familiar with scientific word processors, this would be a good time to learn. 
But remember, while a stylistically clear presentation is very important, it does not 
compensate for poor data or analysis or an illogical presentation. With this in mind, we 
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give below some information on common practice for the preparation of papers for 
publication in physics and astronomy. While LaTeX is predominant, any scientific word 
processor is acceptable, e.g. Word using the equation editor. Remember, the main goal is 
clarity. Beauty is secondary. In any case the general structure of your report should 
follow the APS guidelines, i.e. abstract, introduction, etc.  

Reports should be formatted according to the guidelines published by the APS for 
Physical Review (physics experiments), or the AAS (astronomy experiments). We 
recommend writing your report using the LaTeX markup language. LaTeX (.tex) files 
are ASCII files, and can be created using any text editor. The LaTeX software converts 
the .tex file into a binary .dvi (device-independent) file, which can then be converted to 
postscript using dvips, or to other printable styles (e.g. pdf). The LaTeX software is 
installed on most departmental computers, and can be downloaded freely from the 
Internet (for example, TeX for Windows is available from the MiKTeX site). LaTeX is a 
very versatile language that can be used on almost any computer operating system.  

LaTeX uses style (.sty) files to control the design of the output text. Many physics and 
astronomy journals today require that submitted paper be formatted using LaTeX, and 
have written style files that format user's text appropriately. Since you will soon be 
writing real papers in these styles, now is a good time to learn them. 

• The American Physical Society uses the RevTeX style. Reports on physics 
experiments should be written in the Physical Review style using RevTeX. The 
Physical Review Style and Notation Guide tells you everything you need to know 
about writing a paper in the correct style for the Physical Review. 

• The American Astronomical Society is also publishes style guidelines for authors. 
The AAS style is called AASTeX. 

You must submit your lab log book along with your report. In principle, the report should 
be readable without the logbook, but you may reference your log for original tables of 
data which are presented graphically in your report. 

By using the appropriate style files, the format of your report will resemble a journal 
article (see for example recent copies of Physical Review or Astrophysical Journal in the 
Library). Some appropriate examples are available in the reference lists for the 
experiments. The outline of one common format is given below; however variations are 
possible. 

• The cover sheet of the report must contain the name of the experiment, your 
name, your lab partner's name and the date the report was submitted. If this 
information is not there the report will be returned without grading. 

• The report should have a descriptive title reflecting what you actually did and an 
abstract of 200 words or less in which you summarize your results, including 
numerical values with units and errors. 

• The main body of the report should contain 
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1. A clear statement of what your report is about. 
2. An SHORT introductory discussion of the physics needed to understand 

what you are doing. There is no need to copy or paraphrase large portions 
of physics textbooks (or the Lab Notes) to your report. 

3. A discussion of how you did the measurements: equipment. technique, 
experimental checks to verify validity of data, etc. 

4. Analysis of your data including error analysis and perhaps presentation of 
more detailed aspects of theory for comparison. 

5. Representative graphs. There is no need to provide each single graphs you 
created on your computer during the data analysis, but a few well selected 
representative graphs are very important, so that the reader can judge the 
accuracy and reliability of your work. 

6. Discussion of the significance of your results. i.e. what does your data 
demonstrate about physics. You should compare your results with results 
from any similar experiments in the literature. Be sure your conclusions 
are logically defensible. 

• The last section of the report contains the list of references. 

Tables 

• Columns have explanatory headers 
• Units are reported in column header 
• Range of numbers should be reasonable 
• Do not report insignificant digits (Excel users beware!) 
• Errors in data should be there, may be in separate column 
• Always give it a caption. 

A poorly formatted table 

A Bad Table: This table is needs to have a better 
caption so that the reader doesn't have to dig 
through your report to figure out what your are 
showing, and the data is poorly presented. Let's 
look at the columns separately: In the first column, 
the data is presented without a unit, and leaves the 
reader wondering if the distance is presented in 
nano-meters, or parsecs. The values are also 
presented with too many leading zeros (which don't 

convey much information). In the second column, data is presented with too many 
significant figures, and the size of the uncertainty is not indicated. Also, the unit should 
have been presented in SI units (the unit is "s" not "sec").  
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A well formatted table 

This is a better presentation of the same information 
shown above. Notice that the table caption tells you 
what has been measured, as well as "when" the data 
was taken. There is enough information in the 
caption to uniquely identify when, where and how 
the data was collected. In addition to the table 
caption, the columns are properly labeled with SI 
units which are chosen so that the data magnitude 
lies between approximately 0.001 and 1000 (it 
might have been better to choose a standard SI magnitude prefix, but that's a quibble). 
The values in the table all have experimental uncertainties, and have been truncated to the 
proper number of significant figures. In addition, the decimal places have been aligned so 
that it is easy to compare the relative magnitudes.  

 

Figures 

• Proper choice of axes: which variables? sensible limits 
• Label axes, with quantity and units 
• Large enough symbols/labels/ticks/anything to read well 
• Data points: 

o Should be large, and different for different data sets (shape, size, color) 
o Should have error bars 
o Should be explained in caption, of if very many different ones, in legend 

• Always give it a caption. 

A poorly drawn figure: 
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This figure has several problems. First, the captions on the X and Y axis are missing, or 
not explanatory. In general, axis captions should contain the units and name of the 
variable being plotted. The next significant problem is that the number of tick marks are 
not matched to the data. There are too few marks on the X axis, and far too many on the 
Y axis. The tick labels are also too small and may be difficult to read if the figure size is 
reduced. In addition, the range of the X axis not appropriate for the data being presented 
and as a result, the figure wastes a lot of space. Further, the same mark is used for both 
sets of data. The mark is also too small so that it is difficult to read and may not be visible 
if the final paper is printed at low resolution, or if the paper is photo-copied. In addition 
to all of these problems, the figure is missing a detailed caption explaining the meaning 
of the two data-sets. 

A well drawn figure: 
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This figure is dramatically better than the figure presented above. Notice that both axises 
are labeled with the variable name, and unit. Further the axis ranges have been chosen to 
spread the data out over the entire figure. The symbols for two data sets are clear and 
different. With the addition of a detailed caption, this figure is ready to be included in a 
report. 

Having drawn a clear figure, it is important to make sure that it is readable in the final 
report. This means that you need to make sure that the labels are large enough to be read 
and that the lines are thick enough to be clearly seen. Remember that your report may be 
printed or photo-copied in black and white so it's a good idea to avoid color in figures 
(unless it's really required). If you need to use color, try to choose colors that will have 
different intensities when printed in black and white. 

 

The Presentation 
Since PHY445/515 tries to provide a flavor of real experimental physics research, you are 
required to make a presentation structured after presentations that you may eventually 
make at conferences. For this reason, PHY445 students will be expected to prepare a 10 
minute talk describing one of the experiments preformed during the semester. Similarly, 
PHY515 students will prepare a poster to be presented in a poster session. Remember that 
the focus of the talk should be to present results of YOUR work. 
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Preparing an Oral Presentation 

For PHY445/6 students an oral presentation of one of the three experiments is required. 
Here some ground rules and suggestions are given for a good presentation. Consult your 
professor before giving your talk. The faculty member in charge on the presentations will 
give you more detailed instruction ahead of time. 

Presentation: 

• Talk format: American Physical Society format; duration 10 minutes typical, 15 
minutes absolute cutoff including time for questions. Count on about 1 minute per 
slide, so make judicious use of the limited space and time. 

• Presentation should be computer based, e.g. using Power Point. We will provide a 
computer for the presentation. Alternatively it may be on transparencies and 
shown on the overhead projector; the blackboard can only be used in response to 
questions. 

• Transparencies and pens can be obtained from the Instructional Laboratory. 
• Expect to answer a few questions at the end of the presentation. 
• Use the feedback from your experiment's instructor, and improve on your written 

report and analysis! 
• Practice your talk some days before the presentation with your partner; allow 

ample time for feedback and modifications. 

Organization of the talk: 

1. Title, author, (partner,) institution, and short outline 
2. Introduction (15%): 

o Short history 
o The interest and/or practical applications 
o The underlying physics 

3. Body of the Talk (50%): 
o Experimental setup and method 
o Data analysis (fits etc.), and theoretical techniques/assumptions 
o Sources and estimation of statistical and systematic uncertainties and 

errors 
4. Results (30%): 

o Result(s) and uncertainties 
o Interpretation of the results in a physical picture; connection of experiment 

with theory 
5. Short conclusion (5%) 
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Preparing a Poster for the PHY 515 Presentation 

PHY 515/516 students present a poster some time during the third lab period. The poster 
session is held during regular lab time; the date is announced at the beginning of the 
Semester. The poster you will prepare serves two purposes: 

• Allow the audience to get a quick impression of your work 
• Provides a basis for verbal discussions. 

The posters are approximately 3' x 4' in size. One way of creating a poster is to use a 
computer and a good quality printer to make individual pages of text/graphics with 
LARGE characters, and pasting these pages to the poster board. Alternatively you can 
use the department’s new printer for posters.  Several samples of "real" posters can be 
found in the basement of the Grad. Physics building. 

The main components: 

• The title - should include the name of the experiment, your name, and your 
partner's name. 

• The abstract - contains the main results, similar to the abstract of a report. 
• The relevant theory - summarized, including the most important equations you are 

using. 
• The experimental results - in the form of graphs; numerical results with errors and 

units. 
• Tables of important data you may want to discuss. 
• Evaluation of data, error estimates. 
• Conclusions. 

The posters will be graded by the entire staff. You should be prepared to answer 
questions about the material presented on the poster. Your original lab notes should be 
available for the discussion. 

Laboratory Safety 

Using Cryogenic Liquids Safely 

The cryogenic liquids (helium and nitrogen) used in the lab are not toxic but can cause 
serious injury or death if misused. You should not use these liquids until you have been 
instructed in their safe use by the staff. The main dangers are listed below. 

• Frostbite. These liquids are extremely cold and can almost instantly cause serious 
damage to any part of your body they touch. Perhaps the most likely danger is 
from a blast of cold gas hitting your hand as the gas rushes from the dewar 
containing the liquid. This can happen, for instance, when your open the valve on 
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a pressurized dewar or when you insert a warm object into a dewar and rapidly 
boil off the liquid. If you grab hold of an object just taken from the liquid your 
skin could easily freeze to it. Never allow the cryogenic liquid to reach your 
eyes, always wear safety glasses. Remember, eye surgery is sometimes done by 
using liquid nitrogen. 

• Explosion. A cubic foot of liquid will yield about 1000 cubic feet of room 
temperature gas. If this gas is held in a closed volume pressures can be generated 
which are sufficient to cause the vessel to explode. For instance, if you leave a 
helium cryostat completely sealed off, as the liquid boils off something will give. 
Liquid helium can freeze air into a solid plug blocking the neck of a storage 
dewar and leading to the danger of an explosion as the pressure builds. Modern 
dewars are designed to minimize this risk, but you must always be sure not to 
leave a dewar open to the atmosphere allowing air to get in. 

The experimental dewars in the lab are glass vacuum flasks. Under some conditions they 
may implode sending glass shards flying in all directions (e.g. into your eyes). The 
dewars are shielded as they are set up. They should not be handled without proper 
protection and then only by the staff. 

• Asphyxiation. In poorly ventilated spaces, large volumes of gas can be generated 
as liquids boil off. This may displace sufficient oxygen from the air that life 
cannot be supported. While this should not happen in the Lab, you should be 
aware of the possible danger under adverse conditions. 

Electrical Safety 

Physiological effects of electrical shock depend on the current involved, not directly on 
the voltage. Organs most sensitive to shock are the brain and the hart. In ordinary lab 
situations most of the resistance is in the contact through the skin, this resistance is 
greatly decreased if the skin is moist. 

At low frequencies (below few kHz) the main effects are shocks. 

• sensitivity threshold is around 1 μA 
• painful sensation starts at about 5 μA 

• at 10-20 μA sustained muscular contraction occurs; can't let go; contraction of 
chest muscles may stop breathing 

• 70-300 μA : current passing through chest may provoke fibrillation in the hart; 
very often fatal 

It is possible to get dangerous shock with voltages as low as 50V. 

Radio frequency currents do not induce shocks but may produce burns or dangerous 
heating (depending on current density). 
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Precautions: 

• All exposed conducting parts of instruments should be properly grounded. 
• All wires, contacts having more than 25 V to ground and capable of delivering 

more than a few μA of current must be protected against the possibility of 
accidental contact. Please bring to the attention of the staff any dubious case. 

• Do not work on powered circuits unless you are absolutely sure that no 
voltages above 25V can be present. 

Laser Safety 

The experiment to study the Doppler free spectroscopy uses diode lasers. Here are some 
safety considerations about lasers that you should follow. 

Diode lasers pose no significant electrical hazards because of their low operating 
voltages. The eye hazards of lasers depend on the wavelength, operating power and 
focusing optics. The rapid divergence of diode laser beam gives some protection against 
eye damage by dispersing the power over a large area. However, collimation or focusing 
of the beam, as required for most applications, removes this safety factor. 

Laser powers of a few milliwatts or less are far from deadly and may not even be felt as a 
warm spot on your skin. The intensity (power per unit area) of a diode laser GaAlAs (for 
780nm) is comparable to sunlight (although it is spread over a much smaller area). 
Because both sunlight and a laser beam are made of parallel rays, the eye can focus both 
onto very small spots on the retina. If the eye stares at either the sun or a laser beam long 
enough, the intensity at the retina can be high enough to cause permanent damage. There 
are no hard-and-fast rules for exactly how much exposure will cause what type of 
damage, so caution should be the watchword. However, an inadvertent momentary glance 
into a milliwatt beam is no more likely to cause instantaneous blindness than an 
accidental glance at the sun. 

The wavelength of the diodes used in the laboratory is 780 nm. The eye is insensitive to 
those wavelengths, although some people can sense 780 mn as red glow, but the response 
is only about 0.001 times as strong as to the Helium Neon line (633 nm). Do not be 
fooled into thinking that a weak looking beam must be very low in power. In fact the 
invisibility of the radiation removes the eye aversion response that protects you in the He-
Ne case. 

Notes taken from: Jeff Hecht, The Laser Guidebook, Second edition, Mc Graw-Hill, New 
York (1992). 

Radiation Safety and Protection 

On several experiments in the Advanced Physics Laboratory you will work with 
radioactive sources. At this time, these are 
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• Gamma-gamma angular correlation experiment using 22Na  and 60Co γ sources; 
• Compton scattering using 22Na , 137Cs, 57Co, and 133Ba γ sources. 
• The Mossbauer Effect using a 57Co γ and X-ray source. 

Care is always required when handling any radioactive source.  You are encouraged to 
monitor your handling of any source with the radiation dose rate meter in the lab (which 
reads dose rates in mR/hour).  The permanent source at the Compton experiment is a 
strong γ source. This report gives you a brief introduction into the basic aspects and rules 
of radiation safety. In order to introduce you to this important and generally unfamiliar 
subject we touch on additional radiation types, such as neutrons, protons and α particles, 
and their hazards. You will NOT encounter these in this laboratory. 

Radiation Activity 

Hazardous nuclear radiation originates from number of sources: 

1. The nuclear decay of radioactive sources produces γ rays (energetic photons of 
energies from keV to many MeV) β rays (energetic electrons and positrons), α particles 
(energetic helium nuclei), and fission fragments (very energetic heavy nuclei like 
Barium). 

2. Nuclear reactions inside nuclear reactors produce neutrons and radioactive nuclei as 
well as fission fragments. 

3. Energetic charged particle beams at accelerators can produce all of the above particles 
in nuclear reactions, plus energetic protons and charged mesons. 

4. These charged-particle beams themselves represent hazardous radiation, as does 
cosmic ray radiation, such as muons (μ). 

The activity of radiation associated with a source is defined as follows: If a radioactive 
source contains N(0) radioactive nuclei at a time t = 0, then after a time t there remain 
N(t) = 

N(0) exp{-t/τ} radioactive nuclei. Here, τ is the mean life time. The activity A of the 
source at time t is the number of decays per unit time: 

A(t) = λ N(t) = λ N(0) exp{- λt}, 

where the λ = 1/ τ decay constant is used. Note that the strength of a source decreases 
with time. 

The nominal strength of the source, and the date when this was the actual strength, is 
written on each source. The present strength can be calculated if the decay rate (or 
lifetime) is known. 
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The units of activity are: 

1 Becquerel = 1 Bq = 1 disintegration/sec 

1 Curie = 1 Ci = 2.22 x 1012 disintegration/min 

1 milliCurie = 1 mCi = 10-3 Ci 

1 microCurie = 1 μCi = 10-6 Ci 

The Ci is the historical unit, the Bq is the SI unit. Note that each disintegration can 
involve more than one radiation product emitted. 

Mostly you will deal with μCi strengths. A mCi source is already strong. The 137Cs in the 
Compton effect is a 300μCi source. Table 1. shows the radioactivity (in Becquerel) of 
various sources. 

1 adult human 3000 Bq 

1 kg of coffee 1000 Bq 

1 kg superphosphate fertiliser 5000 Bq 

The air in a 100 square metre home (radon) 3000 Bq 

1 household smoke detector 30 000 Bq 

Radioisotope for medical diagnosis 70 million Bq 

Radioisotope source for medical therapy 100 000 000 million Bq 

1 kg 50-year old vitrified high-level nuclear 
waste 10 000 000 million Bq 

1 kg uranium 10 million Bq 

1 kg low level waste 1 million Bq 

1 kg of coal ash 2000 Bq 

1 kg of granite 1000 Bq 

Table 1. Radioactivity of some natural and other materials 

Energy Deposition of Radiation 

Nuclear radiation is hazardous to living tissue because it ionizes directly or through 
secondary processes the atoms, and breaks up molecules, in the cells. This ionization is 
proportional to the energy deposited in the material. The energy deposited in a unit of 
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mass is called the Radiation Dose. Its traditional unit is the rad and the SI unit is the Gray 
(Gy). 

1 rad = 100 ergs/gr = 62.4 x 106 MeV/gr. 

1 Gray = 1 Gy = 1 Joule/kg, so 1 rad ≅ 10-2Gy. 

The Roentgen (R) is an older unit for X rays and γ rays expressing the amount of 
ionization produced in a unit volume of air. 1 R = 0.96 rad in human tissue, for energies 
between 0.1 and 3 MeV (which covers most radioactive sources and X-ray machines). 

Doses in the range of 100 rads lead to clinical symptoms, millirad doses are the level for 
which rules exist for generally allowed radiation levels and for radiation protection. Note 
that the rad does not contain the time over which the radiation dose was obtained, i.e. 
whether it was absorbed in seconds, or in months. 

The human body carries an amazing amount of radioactivity within itself, mostly in the 
form of 40K and 14C. Table 2 contains a breakdown of annual doses (in rad) received by 
the human body from (internal) natural sources. In addition, we are bombarded by cosmic 
radiation (muons) at a rate of about 0.01 particle /cm2 sec, and we are exposed to other 
sources of natural radioactivity. 

Body content in 70 kg man Annual dose 

Radionuclide (picocurie) (dis/min) (mrad) 
40K 120,000 266,000 18 (whole body) 
14C 87,000 193,000 1 (whole body) 
226Ra 40 89 0.7 (bone lining) 
210Po 500 1,110 .6 (gonads) 

   3 (bone) 
90Sr (1973) 1,300 2,886 2.6 (endosteal bone) 

   1.8 (bone marrow) 

Table 2. Radioactive doses due to various sources in the human body 

The biological damage effect by a given dose depends importantly on the density with 
which the energy was deposited. Different radiations differ in their effectiveness because 
they lose energy by different rates as they traverse the body material and thus create 
different ionization densities. 

The rate of energy deposition is easily defined for charged particles, which ionize directly 
and continuously along their path. It is expressed by the Linear Energy Transfer (LET). 
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The higher the LET, i.e. the shorter the distance over which a given amount of energy is 
transmitted to the body tissue, the more destructive is the radiation to the tissue. Table 3 
gives some LET values for various charged particles. Electrons have a small LET value 
except at very low energy. α particles from radioactive sources have typically energies 
around 5 MeV. Their LET is very large. However, they only penetrate 47 μm into the 
body and thus present a hazard only if they are ingested. An interesting case are protons: 
At an initial energy of 100 MeV, their LET is small and they do little damage. At the end 
of their range, when they have only 1 MeV left, their LET is large and they do a lot of 
damage. Thus accelerated protons are used for cancer therapy with the energy adjusted so 
that the beam stops in the tumor. 100 MeV protons travel about 7.5 cm into the human 
body. Beams for cancer therapy have typically energies above 250 MeV. 

   Energy Velocity LET Range 

Particle Massa Charge (MeV) (cm/sec) (MeV/cm) (microns)

Electron 1 -1 0.01 0.59 x 1010 23.2 2.5 

   .1 1.64 x 1010 4.20 140 

   1.0 2.82 x 1010 1.87 4,300 

   10.0 3.00 x 1010 2.00b 48,800 

   100 3.00 x 1010 2.20c 325,000 

Proton 1835 +1 1.0 1.4 x 109 268 23 

   10 4.4 x 109 47 1,180 

   100 1.3 x 1010 7.4 75,700 

Alpha 7340 + 2 1.0 0.7 x 109 1,410d 7.2 

   5.3e 1.6 x 109 474 47 

a) Mass is taken relative to the electron mass. 
b) An additional 0.20 MeV/cm is lost by emission of photons. 
c) An additional 2.8 MeV/cm is lost by emission of photons. 
d) Includes only energies imparted locally. About 24 percent of the total energy lost 

by the alpha particle is imparted to electrons in amounts greater than 100 eV per 
collision. These electrons are considered to lose their energy away from the track, 
and their energy loss has not been included in the local energy loss of the alpha 
particle. 

e) Energy of alpha particle from 210Po. 

Table 3. Transfer of energy (LET) per cm in water by charged particles. 
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Energy Attenuation, μ (cm-1) 

(Mev) Water Iron Lead Concrete 

0.01 4.99 1354 1453 62.3 

0.1 0.168 2.69 59.4 0.400 

1 .071 0.469 0.776 .150 

10 .022 .235 .549 .054 

100 .017 .340 1.056 .055 

Note: The densities of the above materials, in g/cm3, are as follows: 

water, 1; iron, 7.87; lead, 11.35; concrete, 2.35. 

Table 4. Photon attenuation coefficients. 

Being uncharged, γ rays do not ionize directly, but produce energetic electrons in the 
material through the photo-, Compton-, and pair effects. These electrons then lose their 
energy with the same LET as primary ones. However, these conversion reactions have 
small probabilities, given by P(x) = μx, where μ = 0.07 cm-1 is the attenuation coefficient 
for 1 MeV γ rays in water. A 1.33-MeV γ- photon from a 60Co source travels 16.4 cm 
between interactions in tissue. Table 4 gives various photon attenuation coefficients. 
Neutrons also do not ionize directly but react with the nuclei in the tissue, most 
importantly with hydrogen. The secondary recoils then produce ionization. Thus neutrons 
lose energy much in the same manner as γ rays. Neutrons of less than 100 keV have an 
attenuation coefficient μ = 10 cm-1 in tissue (density =1 g /cm3). 

The Equivalent Dose measures the biological effectiveness of a radiation. A "quality" 
factor (really a dys-quality) QF is defined that converts the radiation energy into an 
equivalent biological damage. The unit of the equivalent dose are the rem ("radiation 
equivalent man") and the SI unit Sievert: 

1 rem = 1 rad x QF 

1 Sv = 1 Gy x QF 

Table 5 lists quality factors for various radiations in water. For estimates, one often uses 
QF = 1 for γ rays and electrons, QF = 10 for fast neutrons and protons up to 10 MeV, and 
QF = 20 for α particles and heavy ions. 

With these well defined basic quantities and units, we can take a quick look at the 
biological effects of the radiation: 
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10,000 mSv (10 sieverts) in a short-term dose would cause immediate illness and 
subsequent death within a few weeks. 

1,000 mSv (1 sievert) in a short term dose would probably cause (temporary) illness such 
as nausea, but not death, and would probably cause cancer many years later in 5 of every 
100 persons exposed to this dose. 

20 mSv per year averaged over 5 years is the limit for nuclear industry employees and 
uranium or mineral sands miners. 

10 mSv/yr is the maximum actual dose received by Australian uranium miners. 

2-3 mSv/yr (approx) is the normal background radiation from natural sources, including 
an average of 0.7 mSv/yr from radon in air. This is close to the minimum dose received 
by all humans on earth. This dose corresponds to 200-300 mrem. 

0.05 mSv, a fraction of natural background radiation, is the design target for maximum 
annual radiation at the perimeter fence of a nuclear electricity generating station. In 
practice the actual dose is less. 

1. X rays, electrons and positrons of any specific ionization 

QF = 1 

2. Heavy ionizing particles 

Average LET in water 

(MeV/cm) QF 

35 or less 1 

35 to 70 1 to 2 

70 to 230 2 to 5 

230 to 530 5 to 10 

530 to 1750 10 to 20 

1750 and above 20 

• For practical purposes, a QF of 10 is often used for fast neutrons and protons up 
to 10 MeV. A QF of 20 is used for alpha particles and other multiply charged 
particles. The following values for quality factors may be used for neutrons when 
the neutron energy spectrum is known: 
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Neutron Energy (MeV) QF 

Thermal 2 

0.0001 2 

0.01 2.5 

0.1 7.5 

0.5 11 

1.0 11 

Table 5 Quality factors of various radiation types. 

Dose Rates and Radiation Shielding 

There are four ways in which we can protect ourselves - time, distance, shielding and 
containment: 

Time: For people who are exposed to radiation through their work in addition to natural 
background radiation, the dose is reduced and the risk of illness made almost nil by 
limiting exposure time. 

Distance: In the same way that heat from a fire is less the further away you are, so the 
intensity of radiation decreases the further you are from the source of the radiation. 

Shielding: Barriers of lead, concrete or water give good protection from penetrating 
radiation such as gamma rays. Radioactive materials are therefore often stored or handled 
under water, or by remote control in rooms constructed of thick concrete or lined with 
lead. 

Containment: Radioactive materials are confined in the smallest possible space and kept 
out of the environment. Radioactive isotopes for medical use, for example, are dispensed 
in closed handling facilities, while nuclear reactors operate within closed systems with 
multiple barriers which keep the radioactive materials contained. Rooms have a reduced 
air pressure so that any 

leaks occur into the room and not out from the room. 

A 22Na source provides a good example for shielding. To illustrate this we will briefly go 
through a quantitative exercise for its β and γ rays. 

22Na decays to 22Ne by emitting positrons with a peak energy of 0.45 MeV. 22Ne then 
emits a γ ray with E, = 1.27 MeV.  Mostly at the end of its path the positron annihilates 
with atomic electrons producing two γ rays with E = 511 keV each. Thus each 
disintegration produces 1 e+ and 3 γ's. 
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A 22Na source with a strength of 1 mCi thus produces A = 2.22 x 109 β's /min which 
radiate into 4π solid angle. If you hold an open source with your fingers they could 
intercept the total activity over an area of 1 cm2. Each β ray has in average about 1/2 the 
maximal (end point) energy of 0.45 MeV. Fig. 1 gives the range of β rays in Aluminum 
as a function of their energy. The range is given in units of area density (mg/cm2) because 
in these units the curve applies closely to all materials. The range for 225 keV positrons 
in human tissue (ρ = 1000 mg/cm3) is 50 x 10-3 cm = 0.5 mm. The dose deposited by the 
source is then: 

Dose/min = Activity x energy/event /(mass affected)/ 62.4 x 106 MeV,/rad 

= 2.22 x 109 x 0.225/(5 x 10-2 x 62.4 x 106) = 160 rad/min. 

This is a large dose deposited in the skin of your fingers. Thus the source must be 
shielded. It takes only a very thin shield to stop the α's. For instance the range of 450 keV 
β's in Aluminum is 150 mg/cm2 /2.7 g/cm3 = 0.055 cm, only 1/2 mm. Since we need the 
source only for its γ's the radioactivity is already packaged such that the β's don't emerge 
from the source (a closed source). 

The γ rays are more penetrating. If I0 γ's are hitting your body, the number remaining 
after a distance d is I(d) = I0 exp{- μd}, and the number absorbed is then A(d) = I0(l - 
exp{- μd}). For human tissue (water) μ = 0.071 cm-1 (see Table 3). Thus over a body 
thickness d = 50 cm A = 0I × 0.88, i.e. 88 % of the intensity (and the energy) is absorbed. 
However, the whole body dose is very small since the volume and thus the mass over 
which the energy is deposited is small. 

Nevertheless, we need to shield the γ source. As Table 4 and Fig. 2 shows the most 
effective shielding material is lead. The intensity of 1 MeV γ rays remaining after 2 
inches of lead (see Table 3) is I(5cm) = I0 exp{-776 x 5} = 0.02 I0 . 2 inches of lead 
leaves 2% of I0; after 4 inches (10 cm) only 0.043% survives. Thus the Compton 
experiment shields the source with two lead bricks in all directions. 



 24

 

Fig. 1 Range of β rays in Aluminum as a function of energy 

                     
Fig. 2.  Attenuation coefficient of lead for γ rays of various energies. Use the density of 
lead (ρ= 11.35 g/cm3) to obtain the attenuation length in cm. 
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Least Square fits to an arbitrary function using EXCEL 

(Hybrid grid-gradient searches of χ2 surfaces for nonlinear fits) 

Introduction 

The following should merely be regarded as an addendum to Chapter 8 of Bevington and 
Robinson's Data Reduction and Error Analysis. This is therefore not a self-contained 
manual on "how to do error analysis in the Graduate and Senior Lab and See you later". 
Referral to Bevington and Robinson for concepts, definitions, theory and the practice of 
Error-analysis will be necessary. Furthermore what is given here is a mere minimum of 
how to fit an arbitrary function to a given set data. There are several other methods, 
which are equally as valid. One can make one's error-analysis really as elaborate as one 
wants in any way which is scientifically, mathematically and logically sound and 
accepted. Some of these are also discussed in Bevington and Robinson. Be very careful 
though of prepackaged error-analysis programs, -routines or magic boxes, if you do not 
know how they work and what exactly they return as results. It is therefore not advisable 
to use the Trendline command in the Insert menu of EXCEL. As said, what follows 
below is a minimum of requirements and just one particular way of doing it. We will 
proceed by example. 

Set-up 

Consider for instance the Geiger counter data from an irradiated silver piece used as 
example in chapter 8 (see Table 8.1). The theoretical shape of the data is given by the 
function 

y(t) = a1 + a2 exp(-t/ a4 ) + a3 exp(-t/ a5 ) 

For simplicity's sake we will assume the distribution to be Poisson, hence the error in 
each point is just the square root (Only so when p<<1 ; Chapter 2 Bevington and 
Robinson; be careful when doing real data analysis, whether such assumptions are valid; 
test!). Also, we will ignore the error in the time, since we will assume it to be far smaller 
than the error in the counts. If this is not the case, see Chapter 6, page 100 in Bevington 
and Robinson. This will not however detract from or change the method to fit functions 
described below. 

A first necessity is obviously to enter the data into EXCEL. In most cases you will have 
to do this manually, though for some experiments it has been automated; in that case the 
TA will explain it to you. It is useful to leave some rows free at the top; you will see why. 
HINT: From experience always immediately label your data columns rows appropriately 
and with the right units; this will make life a lot easier. 

You should now have three columns of data: one for the x-coordinate (time), one for the 
y coordinate (counts) and one for the error in the y coordinate (Δcts). In the rows left free 
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at the top just type as text the function you will be fitting, this is convenient as a 
reminder. Label a set of cells with the appropriate parameter names leaving a set of cells 
adjacent to the names free. This is where the actual values of the parameters will appear. 
Next (I usually skip a column to keep clearly separated the fir from the actual data) we 
create a column for the fitted function as follows. Select the first cell (below the labeling 
cell) in the column for the fitted function and type there an equal sign followed by the 
expression of the function, using the proper cell address (A1,B23,AC34, etc.) for value of 
the function variable and for value of the to be fitted parameters, in which case each 
element of the cell address should be preceded by a "dollarsign" ($A$1, $B$23, $AC$34, 
etc). For mathematical expressions such as sine, cosine, exponential etc. use the proper 
EXCEL command (it can be found under Function... in the Insert Menu or in the help 
menu). After entering the expression, pressing return will return the calculated value. If 
the cell address now is not preceded by a "dollarsign" EXCEL regards the address-
referral as relative to the original cell (three left, one up), if not as absolute (The cell: 
A1). Thus copying this first cell with the function-expression down will leave the 
parameter-value unchanged while picking out exactly the proper x-value. This procedure 
is standard for any EXCEL routine and will be used frequently. 

The next column we set up is the column of normalized residuals; this is just the 
deviation divided by the error for each data point viz. (y -fit(y))/error(y). How to set such 
a column up is explained in the previous paragraph. The definition of χ2 is the sum of the 
squares of the normalized residuals, (Bevington and Robinson page 67). To find this 
value, use the SUMSQ command in EXCEL. Pick an unused cell in the free area left on 
top and type an equal sign followed by SUMSQ(argument) where argument is a set of 
cell addresses. Cell addresses seperated by a comma are distinct, while those seperated by 
a colon are continuous viz. A1,A10 are the cells A1 and A10, while A1:A10 are the cells 
A1, A2, A3 through A10. Do not forget to label your cell. The normalized χ2 is then the 
χ2 divided by the number of degrees of freedom i.e. number of data points minus number 
of fitting parameters (Bevington and Robinson page 68). The closer the normalized χ2 
will be to 1 the better the fit. Why? See Bevington and Robinson which will also tell you 
why a normalized χ2 less than 1 is somewhat of a disaster (amongst others, page 107). 
We are now completely set up to start performing the fit with EXCEL. 

Fitting 

To find the best fitting funtion to the data we want to minimize χ2. We do this with the 
resident Solver routine in EXCEL, which can be found in the Tools menu. WARNING: 
OUTSIDE OF THE LAB NOT ALL INSTALLATIONS OF EXCEL HAVE THIS 
ROUTINE. A Solver Parameters submenu will appear asking for the proper parameters. 
Our Target Cell will be the χ2 cell, which we want to minimize (min). This we would like 
to accomplish by changing the values of the parameters a1....a5 hence we enter their 
respective addresses (in our case $A$6:$E$6, note the colon and the dollarsigns. the latter 
are required in the Solver submenu). The Solver Options are set to perform a hybrid 
Grid-Gradient search for a minimum in the χ2 hypersurface in parameter space (page 
150ff Bevington and Ronbinson). There is no need to change the default settings, they are 
mainly concerned with optimizing the calculation with respect to CPU and memory use. 
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For those interested look under EXCEL help for the Solver Options Dialog Box. It gives 
a short description of each option. 

Before starting the Solver, however, read carefully pages 147 and 148 on Starting values 
and local minima. The initial values for the parameters a1....a5 are rather important 
otherwise the Solver search routine could get stuck in a local minimum of the χ2 surface. 
We are however looking for the absolute one. Several tries with the Solver routine while 
manually adjusting the parameters if necessary ought to give you the absolute minimum 
of the χ2 surface. 

Besides using the χ2 value as a gauge for correctness of the fit it is also very useful to 
look at the distribution of the normalized residuals. Ideally it should be completely 
random. If it has any distinguishing patterns, it might indicate that the function your are 
fitting does not conform to shape of the data. Another kind of function or a combination 
of two might then be called for as the one to be fitted. 

Errors in the parameters 

Once we have obtained a best fit to our data we must find some way to extract the errors 
of the parameters themselves. We do this by performing a χ2 variation (page 146/7 
Bevington and Robinson) for each parameter that we want to know the uncertainty of. 
Say one wants to know the uncertainty in a4. Then one does the following. One performs 
several Solver routines, each time for the values of a1 , a2 , a3 and a5 
($A$6;$B$6;$C$6;$E$6) while keeping a4 constant at some manually chosen value, 
differing for each time one performs the routine. We thus obtain a set of values of χ2 each 
corresponding to a value of a4. A plot hereof should be a parabola with the minimum at 
the true χ2. The error in a4 is then given by the difference between the true value of a4 
and that where χ2 is exactly 1 more than the minimum. The exact value can be found by 
fitting a parabola to a χ2 vs. a4 plot (Figure 8.3 page 146 Bevington and Robinson). 

Graphical presentation 

Lastly, as data tables are intrinsically rather incomprehensible, we would like to represent 
our data graphically. This can be done with the Chart function in the Insert menu or the 
short-cut Chartwizard button. A Chartwizard submenu will ask you for the range i.e. 
the set of cells you want to plot. Easiest is to give one set of x and y values, in this case 
Range: =$A$11:$A$69,$B$11:$B$59. Note the use of the colons and commas; the 
equality and dollarsigns are necessary. The rest of the steps of the submenu speak for 
themselves. Recommended is the X-Y scattering graph, though, it is the most flexible. 
The graphical tricks that can be performed are innumerable. Clicking on what one wants 
changed usually gives the submenu to make it possible. Only two useful commands will 
be mentioned here. 

One is to insert error-bars into the graph. This is done by selecting (clicking on) the data 
series to which one wants to introduce error-bars. The formula-bar i.e. the bar just above 
the line of column labels A,B,C,D,...will tell you whether you have done so successfully. 
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Then Error-bars in the Insert menu will activate the Error-bar submenu. Naturally we 
will choose Custom Error-bars. The input here is the same format as in Range i.e. an 
equality sign at the beginning and dollarsigns in front of the cell addresses are necessary. 
Clicking on a error-bar one can change its shape and format. It is especially advisable to 
change the Weight (thickness) to the minimum, if not the error-bars will be rather fat and 
clog the picture. 

The other useful command is to have the fit and actual data represented in one graph. 
This is done by the New Data command in the Insert menu. One is than simply asked for 
the range (set of cells) which give the y-values for the new data series. The x-values are 
of course already known. The graph will then show both the actual data as well as the 
fitted curve. Double clicking on any Data series allows you to change its format (Lines, 
Dots, sparsing, thickness color, Error-bars(also) etc.). 

 


